
Netscape Composer Tutorial
This tutorial will show you how to use Netscape Composer to create web pages. Netscape
Composer integrates powerful What-You-See-Is-What-You-Get (WYSIWYG) document
creation capabilities into Netscape Communicator's already rich set of World Wide Web
features. In addition to electronic mail, threaded discussion group, and file transfer features
included in Netscape Communicator, Composer makes composing for the Web, email, or
newsgroups a simple cut-and-paste, drag-and-drop process.

The document creation capabilities in Netscape Composer are designed to provide both
experienced and beginning content creators with a simple yet powerful solution for editing
and publishing online documents. WYSIWYG editing allows first-time users to create dynamic
online documents easily and publish them to local file systems and remote servers with ease.

An overview of Composer and its features

There are a lot of things you can do with Composer:
Work in a WYSIWYG environment. You can see the results of paragraph and font
tags applied as you type.
Add, remove and modify text. Click on any part of a downloaded Web page and
immediately work with text and images.
Drag-and-Drop. Drag-and-drop hyperlinks and images from the bookmark, mail,
news, or browse windows, to a document in the editor (Windows and Macintosh
only). You can also drag an HTML or image file from the Windows File Manager
(Explorer in Windows 95) and drop it in an edit window.
Publish your documents on the Internet. Simplify the process of posting pages to
a server by using one button to copy your files from your local hard disk to a remote
directory or server.
Format text to suit your needs. You can apply paragraph and character styles to
text just as you would in your favorite word-processing application.
Change font, font size and color. Use these features to create pages that focus a
reader's attention where you want.
Include objects in your pages. You can insert tables, images, horizontal lines, and
hyperlinks in the Web documents you create.
Edit JavaScript statements. Include JavaScript in your documents. JavaScript is an
open, cross-platform object scripting language for enterprise networks and the
Internet.

Begin the tutorial below, or jump straight to a particular topic. You may also download a
complete pdf file of the tutorial.

- Begin Tutorial -
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Netscape Composer Tutorial

Getting started with Composer
This section provides an overview of ways to start Composer and create an HTML document.

Quick Links:
Creating a New Document
Editing the Page You're Browsing
Editing an Existing Page
Using the Toolbars and Pop-up Menus
Drag and Drop

Creating a New Document

Choose New|Blank Page from the File menu or click the Composer button (pencil icon) on the Component bar.

A Composer window opens containing a blank page. The original browse window remains open behind the Composer
window.

Editing the Page You're Browsing

Click the Composer button (pencil icon) on the Component bar. You can also choose File|Edit Page. The current
browse window becomes an edit window containing the document you were viewing.

Editing an Existing File

Choose File|Open Page in Composer. A Composer window opens containing the specified file. The original browser
window remains open but behind the Composer window.

Getting Started
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Using the Toolbars and Pop-up Menus

The two Composer toolbars contain buttons corresponding to frequently-used commands. You can access most of
these commands from the menus, but it's generally quicker to use the toolbars.

Composition Toolbar

Use these items to create, open, and save HTML files, publish (upload) files to a remote server, view your
HTML document in the browser, perform standard editing tasks, create links and targets, and insert images, horizontal
rules, and tables.

Formatting Toolbar

Use these items to apply paragraph formatting, specify fonts, font sizes and font styles, apply text color, control text
alignment, and check spelling.

You can reposition a toolbar by dragging it to the area you want. Depending on the area to which you move the
toolbar, it will either snap into position (the area below the menus), or become a floating palette (anywhere else).

Pop-up Menus

Pop-up menus are a handy way to get to frequently used commands: you select an object (such as text or a link) and
then right-click the mouse to display the pop-up menu. The commands that are available are completely dependent on
what's selected when you right-click. For example, right-clicking while on a link provides you with commands to copy
the link or modify its properties. If you right-click while on an image, you'll have quick access to commands to save the
image under a new name or display its properties.

Place the pointer on Use the pop-up menu to

Text Change character, paragraph, or list properties, insert a new
link, or paste from the clipboard.

A link Change link, paragraph, or list properties, open the link in a
browse or edit window, copy or remove the link, or add a
bookmark for the link.

An image Change link, paragraph, or list properties, create a link using
the image, save the image under a new name, cut, copy, or
paste.

A horizontal line Change horizontal line, paragraph, or list properties, cut,
copy, or paste.

An HTML tag marker Change tag, paragraph, or list properties, cut, copy, or paste.

A table Change paragraph, character, or list properties; change table,
row, or cell properties; insert or delete a table, column, row,
or cell; insert a link; paste.

Drag and Drop

Several drag-and-drop operations are available while using Composer. You can:

Getting Started

file:///D|/ITMAStudio/composer/composer1.htm (2 of 3) [10/6/2000 11:17:10 PM]



Drag a link from a browse window and drop it in an edit window. This is like inserting a link in the document
you're editing.
Drag an HTML file (or multiple files) from the Windows File Manager (Explorer in Windows 95) and drop it in an
Composer window to create a link to that file.
Drag a link from a bookmark, mail, or news window and drop it in the Composer window.
Drag an image from a browse window and drop it in the Composer window. This is the easiest way to add
images to your Web pages.
Drag an image file (.GIF or .JPG) from the desk and drop it in an edit window to insert the image in the current
document.

[ Back ] [ Next ]

[ Overview ] [ Getting Started ] [ Working w/pages ] [ Paragraph Formats ] [ Character Formats ] [ Images ] [ Hyperlinks ] [ Tables ] [ Publishing ]
[ Page Properties ] [ Composer Prefs. ] [ HTML and Java ] [ Design Issues ]

Getting Started

file:///D|/ITMAStudio/composer/composer1.htm (3 of 3) [10/6/2000 11:17:10 PM]



Netscape Composer Tutorial

Working with Web pages
This section provides an overview of Composer's basic text editing features.

Quick Links:
Creating Your First Web Page
Browsing Your New Page
Entering Text
Selecting Text
Cut, Copy and Paste
Finding Text
Using the Spell Checker

Creating Your First Web Page

Create a page from scratch that you can build on as you learn more about Composer's features.

Summary

Choose New|Blank Page from the File menu.1.  
Type some text in the Composer window.2.  
Choose Save from the File menu or click the Save button and name the file.3.  

Details

Choose New|Blank Page from the File menu or click the New Document button on the Composition Tools
toolbar.

1.  

You see the Composer window with a blank page, and toolbars at the top.2.  
Choose Save from the File menu (or click the Save button on the Composition toolbar).3.  
When you save your file, name it something unique, such as firstpg.htm, and click OK. If you are using an
operating system that supports long filenames (such as Windows 95), you can give the file an .HTML
extension. (If you skip this step and try to insert a link, the Composer will prompt you to save the file locally
before continuing).

4.  

Type "Netscape Home Page" in the edit window.5.  
Select the text you just typed.6.  
Choose Link from the Insert menu (or click the Link button in the Composition Tools toolbar).The Link
Properties dialog box appears.

7.  

In the Link To text box, type http://home.netscape.com and then click OK.8.  

Note: http://home.netscape.com is the address, or URL (Universal Resource Locator), for Netscape's home page. Every
link in a document has a URL similar to this one.

Once you've completed the steps outlined above, you will have authored a page that links to another page. The
underlined text and different color indicate a link to another Web page.

Browsing Your New Page
To browse your new page:

Choose File|Save and name the page if you haven't already done so.1.  
Choose File|Browse Page to open your newly created page in the Browser window. The Composer window
remains open behind the new Browser window.

2.  

Working w/pages
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If you're online (connected to the Internet), right now you can click on the link and view Netscape's home page. If
you're not, open this file the next time you connect and test your link.

Entering Text

An overview of how text entry works in Composer

Editing text in the Composer works the same as in most word-processing applications. These features are of vital
importance since writing is what you'll spend most of your time doing when creating your Web pages.

As you move the cursor over the Composer window, it appears as an I-beam. When you click the mouse, a small
flashing vertical bar marks the insertion point where text typed is placed in the window. You can start typing right
away.

The Composer supports the special keyboard characters, such as the ampersand and percent sign. To insert
symbols, such as the copyright symbol, run the Windows Character Map application (or use the Key Caps program
on the Macintosh). Change the font to Times Roman, copy the symbol you want, and paste it into the edit window.

Note: Choose Edit|Undo to cancel the effects of the most recently performed command (not all actions can be
undone). Choose Edit|Redo to perform the most recent action again.

Selecting Text

To select words or blocks of text in the Composer window.

Double-click before a line to select a paragraph, and after a line, to select the last word or element in that
line.
Double-click on a word to select the word.
Click before a line to select the entire line.
Use the mouse to drag and select a block of text.

Tip: Choose Show|Paragraph Marks from the View menu to see where paragraph marks are located in your
document--they appear as black rectangles. A short horizontal line appears to indicate the end of the page.

Cut, Copy, and Paste
You can enter text into your document by pasting from almost any source. For example, you can select text on a
page you are viewing in the browse window and copy it with the Edit|Copy command. You can then paste it into the
page you are currently editing by choosing Edit|Paste.

You can also use the Cut, Copy and Paste buttons on the Composition toolbar.

Tip: In Windows, you can right-click your mouse on selected text to quickly cut, copy, or paste the text.

Note: Unlike the Composer window, text that you cut or copy from the Browser window does not retain formatting
information.

Finding Text

Search for text on a page.

Choose Edit|Find, or the Find button on the Composition toolbar.1.  
Enter the characters you want to search for.2.  

Working w/pages

file:///D|/ITMAStudio/composer/composer2.htm (2 of 4) [10/6/2000 11:17:11 PM]



Specify a search option.3.  

Details

Choose Edit|Find in Page to display the Find dialog box.1.  
Enter the characters you wish to search for in the Find What text box.2.  
Choose one of the following Search Options:

Match Case: Makes the match case-sensitive. The default ignores case..  
Up or Down: Specifies whether to begin searching up or down in the file.b.  

3.  

Click Find Next to find the text.4.  

Using the Spell Checker

Summary

Click the Spelling button on the Format Tools toolbar
Choose Spelling from the Tools menu.

Composer checks for spelling errors using its main dictionary, which contains most common words. If Composer
finds a word that is not in the main dictionary, it displays the word in the Spelling dialog box and gives you choices
for correcting the possible misspelling.

You can check the spelling of one word, a selection of text, or an entire document.

To check the spelling in the current document, do one of the following:
On the Format Tools toolbar, click the Spelling button.1.  
From the Tools menu, choose Spelling.2.  

Working w/pages
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The Check Spelling dialog box appears.
For each word that is found, choose whether to correct it, ignore it, or add it to the dictionary.
To return to the document, click the OK button.

About the Check Spelling dialog box:

Word field and Suggestions list - The Word field displays the misspelled word. Click a word in the Suggestions list
or type a correction, and then click Replace or Replace All.

Check - Click to check the spelling of any word you type in the Word field.

Language pop-up menu - To use a different spelling dictionary, click this pop-up menu and choose from the list.

Ignore and Ignore All - Click to continue checking without changing the word (or all occurrences of the word).

Learn - Click to add the word to the dictionary. If there are several words in the Word field, each is added the
dictionary.

Edit Dictionary - Displays a dialog box to add, replace, or remove words from the dictionary.
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[ Overview ] [ Getting Started ] [ Working w/pages ] [ Paragraph Formats ] [ Character Formats ] [ Images ] [ Hyperlinks ] [ Tables ] [ Publishing ]
[ Page Properties ] [ Composer Prefs. ] [ HTML and Java ] [ Design Issues ]

Working w/pages

file:///D|/ITMAStudio/composer/composer2.htm (4 of 4) [10/6/2000 11:17:11 PM]



Netscape Composer Tutorial

Paragraphs Formats
The next two sections discuss ways to format the text in your web pages.

Quick Links:
Formatting
Overview
Headings 1-6
Address
List Item

Description Title
Description Text
The Paragraph Properties dialog

Formatting

An overview of format styles in Composer

There are two types of format styles available to you in Composer:
Paragraph formats: includes heading levels and alignment options, and affects all
paragraph in the selected block of text.

1.  

Character formats: includes font types, styles, sizes, and colors.2.  

This section discusses Paragraph formats. The next section discusses Character formats.

Overview

To apply paragraph styles in Composer:

Select the text and then choose a paragraph style and/or alignment
option from the Formatting toolbar.
Select the text and then choose an item from the Format menu (or in
Windows, right-click the selected text and then choose Paragraph/List
Properties from the pop-up menu).
Select the text and then choose Format|Character Properties to see
the Character Properties dialog. Then select the Paragraph tab

Paragraph formatting affects all paragraphs in the selection, or the paragraph in
which the insertion point located.

These paragraph formats are available in Composer:
Headings
Address
List Item
Description Title

Paragraph Formats
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Description Text

In addition to the formats mentioned above, you can also apply center,
right-justify and left-justify alignment options.

Headings 1-6

Headings divide sections of text. HTML defines six heading levels, which is
reflected in the six heading choices available from the Paragraph control on the
Format Tools toolbar, or by choosing Heading from the Format menu. The
headings differ from regular text by their type size.

Examples of heading levels:

Heading 1

Heading 2

Heading 3

Heading 4

Heading 5

Heading 6

Address

This format is used for a Web page "signature" that indicates who wrote the
page and who to contact for more information, for example:

Carlos_Goldstein@netscape.com

You might want to also include the date, any copyright notices, and other
applicable information. This format usually appears at the bottom of the Web
page and is often preceded by a Horizontal Line.

List Item

The List Item style formats text in a list with a special symbol or bullet at the
beginning of each line. The Composer provides support for the following types
of lists:

Unnumbered: Preceded by a bullet or other symbol.

Paragraph Formats
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Numbered: Preceded by numbers or letters.

Directory: Lists of short items that display horizontally in columns,
such as DOS directory listings.

Menu: Lists of short items but without any bullets or numbers.

Description: Sometimes called a Definition or Glossary list. Lists of
definitions or when an indented list is needed.

Note: Netscape Navigator does not support display of the Directory and Menu
styles, but other browsers may display them.

Tip: In Windows 95, you can right-click your mouse anywhere in a paragraph
and choose Paragraph/List properties to select a list type from the dialog.

Description Title

Use the Description Title format for glossaries, definition lists, or other situations
where left-justified short entries pair up with longer blocks of indented text.
Usually used in combination with the Description Text format, as in this
example:
Glossary Term

Use the Description Text format to indent lines of text, such as listings of
definitions in a glossary or other kinds of list. Use Description Title to
format the glossary term itself.

Description Text

Use the Description Text format for glossaries or other kinds of lists where a
single term or line needs to be associated with a block of indented text, for
example:
Glossary Term

Use the Description Text format to indent lines of text, such as listings of
definitions in a glossary or other kinds of list. Use Description Title to
format the glossary term itself.

The Paragraph Properties dialog

About the Paragraph Properties dialog

Lets you specify a paragraph style and text alignment for the selected
paragraph(s). If you select the list Item paragraph style, additional list-specific
options become available.

Paragraph Formats
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Paragraph style - The available paragraph styles you can apply to the selected
paragraph.

Additional style - Additional attributes for the paragraph style you've selected.
Select List to enable the list and Number/Bullet style fields which allow you to
specify the type of list you want in your document. The Block Quote attribute
can be used w/ any paragraph style.

List style - The type of list you want. Select the Unnumbered, Numbered,
Directory, Menu, or Description List style.

Number/Bullet Style - Specify the type of sequential indicator to use for
Numbered lists, such as 1,2,3, or A,B,C. Bullet: specify the type of bullet to use
(square, circle, or open square) for the Unnumbered list style.

Starting number - The number with which to begin a Numbered list. Type a
number in the box.

Align - Lets you specify whether to align the selected paragraph to the left,
right, or center of the page.

Note: Netscape Navigator does not support the Directory or Menu styles (it
displays these text styles as Normal), but other browsers may display them.
Click OK to make the specified changes and close the dialog box. Click Apply to

Paragraph Formats
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preview the changes you've specified and then click Close to accept the
changes and exit the dialog box.
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Netscape Composer Tutorial

Character Formats
Formatting your text and using color goes a long way to making your Web pages or presentations unique and interesting.
Add images, horizontal lines, tables, and links and you start to understand why the Web has attracted so much attention.
These elements are the stuff of the Web page.

Quick Links:
Formatting
Overview
The Character Properties dialog
Adding Color
Adjusting Font Size
Inserting Horizontal Lines

Formatting

An overview of format styles in Composer

Remember, there are two types of format styles available to you in Composer:
Paragraph formats: includes heading levels and alignment options, and affects all paragraph in the selected block
of text.

1.  

Character formats: includes font types, styles, sizes, and colors.2.  

The previous section discussed Paragraph formats. This section discusses Character formats.

Overview

You can apply character styles to one or more characters, within a paragraph, or spanning parts of multiple paragraphs.
The following character styles are currently supported in the Composer and are available from Format|Character
Properties, the Character Properties dialog, and the toolbar:

Bold
Italic
Fixed width
Superscript
Subscript
Blink
Underline

Note: The JavaScript server and client tags are also treated as special character styles. For more
information about applying JavaScript tags, see Using JavaScript.

The Character Properties dialog

About the Character Properties dialog

Lets you specify attributes such as size, color, style, and JavaScript for the selected character(s).

Character Formats
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Font Face - Choose the font you wish to use.

Color - The color of the selected character(s). You can select to use the document's default text color or
define a custom color.

Size - The point size of the selected character(s). This determines how large or small the characters
appear. This box will be empty if the point size of the selected text varies. You can type a point size in
the box or select one from the drop-down list. Default sets the size to that specified by the default
paragraph style.

Style - The style of the selected character(s), such as italic, bold, or underline. You can also select to
apply a special style called blinking which causes text to blink on and off. JavaScript Allows you to
specify special JavaScript attributes for the selected character(s).

Remove Style Settings - Resets any style checkboxes you have marked to unselected.

Remove All Settings - Resets all settings you have made in this dialog box to unselected or blank.

Click OK to make the specified changes and close the dialog box. Click Apply to preview the changes
you've specified and then click Close to accept the changes and exit the dialog box.

Adding Color

Applying color to selected text is a good way to emphasize different parts of your Web page.
Select the text whose color you want to change and click the Font Color button on the Format
Tools toolbar. In Windows, you can also right-click your mouse on the selected text to display the
Character Properties dialog and select Custom Color.

1.  

Character Formats
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In the Color dialog, select a color or select Other to define your own custom color (below). You can
specify default text color in the Appearance panel of the Composer Preferences dialog.

2.  

Adjusting Font Size

You can adjust font size by choosing Size from the Format menu or using the font size pulldown menu
on the Formatting toolbar.

Character Formats
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Inserting horizontal lines

To insert a horizontal line:
Click the spot in the edit window where you want the line to appear.1.  

Click the Horizontal line toolbar button or choose Insert|Horizontal Line. Right-click on the line
and choose Horizontal Line properties to specify alignment, width, height, and whether to use 3-D
shading.

2.  

Tip: Double-clicking non-text objects in your document lets you modify their properties.
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Images
This section describes how to use images on your web pages.

Quick Links:
Working with Images
Inserting an Image
Images Properties dialog
Alternate Image Properties dialog

Working with Images

There are two ways that images typically are presented. The most common way is as an
inline image, where the picture appears as part of the Web page. The less common way is as
a separate external link that you need to download apart from Web pages. Images are
actually separate image files and do not "live" in the HTML document itself. The images that
appear on your Web page can be image files on your local disk, or on a remote computer.

Most of the current Web browsers support either of two image formats; the Composer
supports both formats as well:

GIF (CompuServe Graphics Interchange Format .GIF extension)
JPEG (Joint Photographic Experts Group .JPG extension)

GIF files lack the higher quality of JPEG files but are usually faster because they're more
compact and optimized for electronic downloading.

You can get images by drawing them yourself, scanning them, or buying them as part of a
commercial clip art package. You can also find images out on the Net in one of the many
image archives available. If you intend to use images on your Web pages, it's wise to create
your own, get permission from the owner of an image, or use royalty-free clip art so you don't
infringe on a possible copyright.

Composer provides two alternatives to displaying images: alternate text and low-resolution
images. Alternate text is displayed in place of images. You should specify alternate text for
those readers who use text-only browsers.

Low resolution images are another alternate to normal image display. You simply specify a
low-resolution image to display while the normal image is loading.

Tip: If the document you're editing contains an animated GIF file, press Esc to stop it from
continually loading so that you can work in the document.

Inserting an Image

Inserting an image in your Web page either copies the image file to the same directory as
that of the parent document - the Web page you're editing - or leaves the image file where it
is, depending on the settings you've specified in Composer Preferences.

Tip: To quickly insert an image, cut and paste it from the clipboard, or drag and drop it to the
location you want on your page.

Images
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To insert an image:
Place the insertion point where you want the image to appear in your document.1.  

Choose Insert|Image or click the Image button on the Character Properties toolbar.
The Image Properties dialog appears, allowing you to specify the source location of
the image, its alignment relative to text, and the amount of space you want around it.

 

2.  

Type the name and path of the image file you want to insert in your document. If you're
not sure of the file name or its location, click Browse to select an image file from the
directory list. Important: If you later move an image file from the specified location, it
will no longer appear on your Web page.

3.  

Type the name of a low-resolution version of the image previously specified. This
image loads first while the higher resolution image is loading on top. If you're not sure
of the file name or its location, click Browse to select an image file from the directory
list. (Optional)

4.  

Type the text that you want to have appear in place of the specified image file. You
should always specify alternative text for readers who use text-only Web browsers,
such as Lynx, or who have graphics turned off. If you don't include this alternative,
your readers might see placeholder images instead of informative text. (Optional)

5.  

Select the options you want.6.  

Images
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Images Properties dialog

About the Image Properties dialog

Lets you insert a new image or modify an existing image's properties. Click OK to make the
specified changes and close the dialog box. Click Apply to preview the changes you've
specified and then click Close to accept the changes and exit the dialog box.

Image file name - The name of the image file you want to insert in your document, or whose
properties you want to modify. The editor supports .GIF and JPG image file formats. If you're
not sure of the file name or its location, click Browse to select an image file from the directory
list.

Edit Image - Click this to edit the image using the external editor you specified in the General
panel of the Composer Preferences dialog box. If you haven't specified an image editor, you
will be prompted to do so.

Leave image at the original location - Normally Composer makes a copy of the image and
places it in the same directory (folder) as your page. If you don't want a copy made, click this
option.

Important: If you move an image file from the specified location, it will no longer appear on
your web page.

Use as background - Click to use the image as a background for your entire page.

Images
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Alignment and Wrapping - The position of the selected image relative to text, top, center, or
bottom. You can also specify whether to have the image right-align or left-align to the page.
To see alignment changes you've made, view your page in the browser.

Dimensions - The height and width of the new or currently selected image as measured in
pixels. Click Original Size to undo any changes to the size you've specified.

Space around - The amount of white space (space where no text is allowed) on the right
and left, top and bottom of the image. You can also select to have a black border surround
the image and specify its width in pixels.

Remove Image Map - Click this to remove all link regions from the image. An image map is
a special type of image that contains links to different locations within the same image.

Extra HTML - Displays a dialog box where users familiar with HTML and JavaScript can add
tags that manipulate the image.

To preview your settings, click Apply. To accept the changes, click OK.

Alternate Image Properties dialog

You'll see this dialog when you select Alt.Text/LowRes... in the Image Properties dialog.

Alternate text - Enter the text string you want to display in place of the image, for example, a
caption or brief description of the image. For example, the Alternate Text for the image above
is "Alt-Image Dialog". You can see this by holding your mouse still over the image.

Low resolution image - Enter the name of the lower resolution image you want to display
while the main image is loading. Click Choose File to browse for the file location.

Edit Image - Click to edit the image using the external editor you specified in the Composer
Preferences General dialog box. If you haven't specified an image editor, you will be
prompted to do so.

Images

file:///D|/ITMAStudio/composer/composer5.htm (4 of 5) [10/6/2000 11:17:18 PM]



[ Back ] [ Next ]

[ Overview ] [ Getting Started ] [ Working w/pages ] [ Paragraph Formats ] [ Character Formats ] [ Images ] [ Hyperlinks ]
[ Tables ] [ Publishing ] [ Page Properties ] [ Composer Prefs. ] [ HTML and Java ] [ Design Issues ]

Images

file:///D|/ITMAStudio/composer/composer5.htm (5 of 5) [10/6/2000 11:17:18 PM]



Netscape Composer Tutorial

Hyperlinks
This section discusses the creation of Hyperlinks, which provide pathways to other pages and
sites.

Quick Links:
Working with Hyperlinks
About URLs
Creating Links
Link Properties dialog
Linking Images
Linking to Targets
Relative and Absolute Links

Working with Hyperlinks

A hyperlink is an active part of a document. When you click a hyperlink, you can link to
Parts of the same Web page.
Files on your computer.
Computers on the Internet.

Hypertext and hyperlink documents are commonplace in computing now. Consider the MS
Windows, Macintosh, and OS/2 Help systems, for example. Help typically displays
highlighted areas that you can click to access additional information. This other information
might be contained elsewhere in the same file or in another help file on your computer. On
the Web, hyperlinks access information on your own computer, and potentially on any
accessible computer on the Internet. The information you access, stored in computer files,
can produce words, sounds, pictures, or even action video on your own computer.

About URLs

Uniform Resource Locators or URLs are street addresses for bits of information on the
Internet. Most of the time, you can avoid trying to figure out your own URLs by simply
navigating to the information you want to point to with your browser, and then copying and
pasting the long string of "stuff" into your link. But it's often useful to understand what a URL
is all about, and why it has to be so long and complex. Also, when you begin publishing your
own information on the Web, you'll want to know something about URLs so that you can tell
people how to find your Web page.

Most URLs have four parts: the protocol, the host name, the directory, and the file name; for
example:

http://mysystem.com/docs/index.htm
The protocol (http:) is how the document is accessed; that is, the type of protocol or
program your browser will use to get the file. If the browser is using HTTP to get to the
file, the protocol part is http. If the browser uses FTP, it's ftp.

1.  

The host name (mysystem.com) is the system on the Internet where the information is
stored, such as home.netscape.com. You can have the same host name but have
different URLs with different protocols, for example:

2.  

Hyperlinks
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http://mysystem.com

ftp://mysystem.com

gopher://mysystem.com

This is the same machine, but with three different information servers. As long as all
three are installed on that system and available, there's no problem having the same
host name.
The directory (/docs) is the location of the file or other form of information on the host.
The directory might be the actual directory and file name, or it can be another indicator
that the protocol uses to refer to the location of that information.

3.  

The file name (index.html) is the .HTML file for the Web page.4.  

Creating Links

To create links in your page to other documents.

Summary

Select the text or image you want to create a link for.1.  
Choose Insert|Link or click the Link button on the Composition Tools toolbar2.  
Enter the file name or URL to link to.3.  

Tip: To create a link to a page displayed in the browser, drag the link icon from the browse
window (left of the location box) to an edit window.

When you link to a local document, you're linking to a document on your computer;
documents you reference don't have to be in the same directory (it's a good idea though).
Linking to a remote document means you're linking to somewhere on the Internet rather than
on your local disk.

Details

You can create links in your documents by dragging them from other windows and then
dropping them into the edit window. For example, you can drag a link from a browse,
bookmark, mail, or news window and drop it on a document in the Composer window. You
can also create links using the Link Properties dialog.

Select the text or image you want to create the link for.1.  

Choose Insert|Link or click the Link button on the Composition Tools toolbar. You'll
see the Link Properties dialog.

2.  

Hyperlinks
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Link Source displays the selected text you want to use to create a link. To change this
text, select the text in your document and retype. To see the change reflected in the
dialog, select the text before opening the dialog. Note: If you don't have any text
selected when inserting a new link, the title of the document to which you're linking
appears in your document as the link text.

3.  

Type the local file name or remote URL to link to the selected text. Click Browse File
to select a local file.

4.  

Select a named target present in the current document or selected file (depending on
how you've set the "Show targets in" option). Select a target to which you want to link
the selected text. The Show targets in option lets you specify displaying either the
named targets in the current document or those in the file specified in the Link to page
or file box.

5.  

Click Apply to make the changes you've specified and leave the dialog box open. Click
OK to make the specified changes and close the dialog box.

6.  

Link Properties dialog

About the Link Properties dialog

Lets you insert a new link or modify an existing link's properties. Click OK to make the
specified changes and close the dialog box. Click Apply to preview the changes you've
specified and then click Close to accept the changes and exit the dialog box.

Hyperlinks
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Link source - Displays the selected text or image you want to use to create a link. To change
linked text, select the text in your document and retype it. To see the change reflected in the
dialog, select the text before opening the dialog. Note: If you don't have any text selected
when inserting a new link, the title of the document to which you're linking appears in your
document as the link text.

Link to page or file - The local file name or remote URL to which you want the selected text
to link. Type a URL or click Browse File to select a file.

Choose File - Lets you select an HTML file to link to

Remove Link - Unlinks the selected linked text. The Link to page or file box is cleared. If the
current selection contains more than one link, an alert box appears asking you if you want to
remove all links.

Select a named target - The named targets present in the current document or selected file
(depending on how you've set the "Show targets in" option). Select a target to which you want
to link the selected text. Targets are also known as "anchors" or "bookmarks".

Show targets in - Lets you specify to display either the named targets in the current local
document or those in the local file specified in the Link to page or file box.

Linking Images

Summary

Hyperlinks
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Insert an image1.  
Click the Link button on the Composition Tools toolbar2.  
Specify a link location.3.  

Details

Just as with text, you can configure images to behave as links in your documents. When you
click a linked image, the browse window displays the page that the image is linked to.

Insert an image on your page.1.  
Select the image and then choose the Link button on the Composition Tools toolbar.
You see the Link properties dialog box.

2.  

Specify a link location.3.  
Select File|Browse Page and then click on the image to go to the linked page.4.  

Linking to Targets

If you want to link to a specific place within a document rather than just linking to the
document itself, you create a target (also called anchor or bookmark in HTML). You can do
this by inserting a target in one document, and then creating a link in the same document, or
another document that points to that target. When you click on the link in the browser, the
browser opens the document containing the target and scrolls to the target location. For
example, the seven links at the top of this page link to the orange topic headings throughout
the page. These headings have been defined as targets. This makes it easier for you to jump
to a specific location on the page.

Place the cursor at the beginning of a line for which you want to create a target, or
select some text at the beginning of a line.

1.  

Choose Insert|Target or click the Target button on the Character Properties toolbar.2.  

Type a name for the target in the edit box; it can be up to 30 characters long. This
name will appear in the target list of the Link Properties dialog. If you selected some
text in step one, this box will already contain a default target name.

3.  

Click OK. A special Target icon appears in your document (only visible in edit mode) to
mark the location of the link.

4.  

Insert a link and have it point to the target.5.  

Choose File|Browse Page and click the link you just created to go to the location
marked by the selected target.

6.  

Hyperlinks
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Relative and Absolute Links

When you specify the path name of a file to be linked to as a single file name, Navigator
looks for the listed file in the current directory (same directory as the current file), even if it is
looking at that file over a network. This is a relative path name. Relative path names point to
the document you want to link to by describing its relation to the current document.

Relative path names

Path name Means

link.htm link.htm is located in the current directory.

files/link.htm
link.htm is located in the directory (or folder)
called files and the files directory is located in
the current directory.

docs/files/link.htm
link.htm is located in the files directory, which
is located in the docs directory, which is
located in the current directory.

../link.htm

link.htm is located in the directory (or folder)
above the current directory (the same
directory the current directory is in). You can
use multiple "../" to indicate a file location
further up the directory structure.

Absolute path names point to the document by starting at the top level of your
directory hierarchy and working down through all the subdirectories to reach the
file. You should use absolute path names when linking to a page from another
Web site, such as the Netscape site.

Note: Check both publish options in the Composer Preferences dialog to take
care of this automatically.

Generally, when linking together your own documents, you'll want to use relative
path names. If you specify your links as absolute path names and then move
your files elsewhere on the disk, rename a directory or a disk listed in that
absolute path, or publish your pages to a server, then your links to these files
might not work.

Absolute path names or URLs

Path name or URL Means

/docs/test/link.htm link.htm is located in the directory
/docs/test.

/C|/docs/html/link.htm link.htm is located on the C: drive in
the directory docs/htm.

http://netscape.com/link.htm link.htm is located on the Netscape
Web server.

Hyperlinks
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Netscape Composer Tutorial

Tables
Tables are useful for presenting information you want to display in a grid, such as a calendar,
or in a spreadsheet, such as financial data. But you can also use tables whenever you want
to have greater control over page layout than you normally would. For example, you could
combine graphics in a table to create a resume or a newsletter. Or, you could create a table
that encompasses an entire page, and then nest tables within the main table for even more
layout control.

Quick Links:
Inserting a Table
New Table Properties dialog
Selecting and Deleting Tables
Adding and Deleting Rows, Columns, and Cells
Setting Table Properties
Table Properties dialog box
Setting Row Properties
Row Properties dialog
Setting Cell Properties
The Cell Properties dialog
Displaying Tables

Inserting a Table

Summary

To insert a table:
Place the insertion point where you want the table to appear in your document.1.  
Choose Table from the Insert menu or click the Table button on the Format Tools
toolbar.

2.  

In the New Table Properties dialog, set the properties you want.3.  
Click OK to accept the settings and close the dialog box. Click Apply to preview the
settings you've specified and then click Close to accept them and exit the dialog box.

4.  

New Table Properties dialog

About the New Table Properties dialog

Lets you create a table and specify attributes such as number of rows and columns, border
line width, cell spacing and padding, table width and height, color, and captioning. Click OK to
make the specified changes and close the dialog box. Click Apply to preview the changes
you've specified and then click Close to accept the changes and exit the dialog box.

Tables
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Number of rows - The number of rows in the table. Type a number in the box.

Number of columns - The number of columns in the table. Type a number in the box.

Table alignment - Lets you select a left-justified, centered, or right-justified alignment for the
table within the document.

Include caption - Lets you inserts space for a centered line of text above or below the
selected table.

Border line width - The size (in pixels) of the border lines around cells. Type a number in the
box. Type 0 to make the border invisible.

Cell spacing - The space (in pixels) between cells in the selected table. Type a number in
the box.

Cell padding - The padding (in pixels) within each cell. This sets the top, bottom, right, and
left margins of each cell in the selected table. Type a number in the box.

Table width - The width of the selected table. You can specify table width as a percent of the
window width or as a number of pixels. If you specify the width as a percent of the window,
the table width changes whenever the window changes. Type a number in the box and select

Tables
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"pixels" or "% of window."

Table min. height - The minimum height of the selected table. This is the smallest height the
table can have. If you type more text in the table, the table automatically resizes to fit the text
you enter. You can specify table height as a percent of the total window height or as a
number of pixels. If you specify the height as a percent of the window, the table height
changes whenever the window height changes. Type a number in the box and select "pixels"
or "% of window."

Table Background - Select a background color for cells in the selected table. You can use
the document's default background color as specified in Page Properties|Appearance, or
define a custom color. You can also use an image as the background of the table.

Note: If you are inserting a table within a table (called nesting tables), you can also set the
minimum height and width of the nested table as a percentage of the parent cell (the cell of
the table in which the nested table resides). The nested tables height and width changes
whenever the parent tables height and width changes. Type a number in the box and then
select "% of parent cell."

Selecting and Deleting Tables

To select a table: place the insertion point inside the table and then choose Edit|Select
Table. Then you can cut or copy the table to paste somewhere else in your document.

To delete a table: place the insertion point inside the table and then choose Edit|Delete
Table.

Adding and Deleting Rows, Columns, and Cells

To add a row, column, or cell: place the insertion point in the table where you want the
addition to appear. Then choose Insert|Table|Row (or Table|Column or Table|Cell).

To delete a row, column, or cell: place the insertion point inside the row, column, or cell you
want to delete. Then choose Edit|Delete Table|Row (or Delete Table|Column or
Delete|Table|Cell).

Setting Table Properties

Once you've created a table, choose Format|Table Properties to set various properties for
rows and cells, or modify the properties you set for the table itself.

Note: The settings you choose in the Table properties dialog box always override the settings
used when you first created the table.

To set table properties:
Place the insertion point in the table.1.  
Choose Format|Table Properties and then select the Table tab.2.  
In the Table Properties dialog, set the properties you want.3.  

Tables
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Table Properties dialog box

About the Table Properties dialog box

Lets you specify attributes such as border line width, cell spacing and padding, width, height,
color, and captioning for the selected table. Click OK to make the specified changes and
close the dialog box. Click Apply to preview the changes you've specified and then click
Close to accept the changes and exit the dialog box.

Table alignment - Lets you select a left-justified, centered, or right-justified alignment for the
table within the document.

Include caption - Lets you inserts space for a centered line of text above or below the
selected table.

Border line width - The size (in pixels) of the border lines around cells. Type a number in the
box.

Cell spacing - The space (in pixels) between cells in the selected table. Type a number in
the box.

Tables
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Cell padding - The padding (in pixels) within each cell. This sets the top, bottom, right, and
left margins of each cell in the selected table. Type a number in the box.

Table width - The width of the selected table. You can specify table width as a percent of the
window width or as a number of pixels. Type a number in the box and select "pixels" or "% of
window."

Table min. height - The minimum height of the selected table. This is the smallest height the
table can have. If you type more text in the table, the table automatically resizes to fit the text
you enter. You can specify table height as a percent of the total window height or as a
number of pixels. If you specify the height as a percent of the window, the table height
changes whenever the window height changes. Type a number in the box and select "pixels"
or "% of window."

Table Background - Select a background color for cells in the selected table. You can use
the document's default background color as specified in Page Properties|Appearance, or
define a custom color. You can also use an image as the background of the table.

Note: If you are inserting a table within a table (called nesting tables), you can also set the
minimum height and width of the nested table as a percentage of the parent cell (the cell of
the table in which the nested table resides). The nested tables height and width changes
whenever the parent tables height and width changes. Type a number in the box and then
select "% of parent cell."

Setting Row Properties

To set row properties:
Place the insertion point in the row you want to modify.1.  
Choose Format|Table Properties and then select the Row tab. The Row properties
panel appears, allowing you to specify properties such as horizontal and vertical text
alignment, and text color.

2.  

Set the properties you want.3.  
Click OK to accept the settings and close the dialog box. Click Apply to preview the
settings you've specified and then click Close to accept them and exit the dialog box.

4.  

Row Properties dialog

About the Row Properties dialog

Lets you specify attributes such as horizontal text alignment, and vertical text alignment, and
text color for the selected table row. Click OK to make the specified changes and close the
dialog box. Click Apply to preview the changes you've specified and then click Close to
accept the changes and exit the dialog box.

Tables
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Text alignment - Position of text relative to the top, bottom, and sides of cells in the selected
table row. You can specify horizontal and vertical alignment or leave the alignment as it was
set when the table was created.

Row Background - Select a background color for cells in the selected table row. You can
use the document's default background color as specified in Page Properties|Appearance,
or define a custom color. You can also use an image as the background.

Setting Cell Properties

To set cell properties:
Place the insertion point in the cell you want to modify.1.  
Choose Format|Table Properties and then select the Cell tab. The Cell properties
panel appears, allowing you to specify properties such as spanning additional rows
and columns, horizontal and vertical text alignment, text style and wrapping, cell width
and height, and cell color.

2.  

Set the properties you want.3.  

Tables
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Click OK to accept the settings and close the dialog box. Click Apply to preview the
settings you've specified and then click Close to accept them and exit the dialog box.

4.  

Note: If you are modifying a table within a table (called a nested table), you can also set the
minimum height and width of the cell in the nested table as a percentage of the parent cell
(the cell of the table in which the nested table resides). The height and width of the cell in the
nested table changes whenever the parent cell's height and width changes. Type a number in
the box and then select "% of parent cell."

The Cell Properties dialog

About the Cell Properties dialog

Lets you specify attributes such as spanning additional rows and columns, horizontal and
vertical text alignment, text style and wrapping, cell width and height, and cell color for the
selected cell. Click OK to make the specified changes and close the dialog box. Click Apply
to preview the changes you've specified and then click Close to accept the changes and exit
the dialog box.

Tables
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Text alignment - Position of text relative to the top, bottom, and sides of the selected cell.
You can specify horizontal and vertical alignment or leave the alignment as it was set when
the table was created.

Cell spans - Lets you set the selected cell to span more than one column or row. Type a
number in the rows box to span additional rows. Type a number in the columns box to span
additional columns.

Header style - Centers the text in the selected cell and sets its style to bold.

Nonbreaking - Lets you set the text in the selected cell to wrap to the next line when it
reaches the preset width of the cell. Turning "Wrap text" off causes the cell (and the table) to
expand to fit the text you type.

Cell width - The width of the selected cell. You can specify cell width as a percent of the
table width or as a number of pixels. If you specify the width as a percent of the table, the cell
width changes whenever the table width changes. Type a number in the box and select
"pixels" or "% of table."

Cell min. height - The minimum height of the selected cell. This is the smallest height the
cell can have. If you type more text in the cell, the cell automatically resizes to fit the text you
enter. You can specify cell height as a percent of the total table height or as a number of
pixels. If you specify the height as a percent of the table, the cell height changes whenever
the table height changes. Type a number in the box and select "pixels" or "% of table."

Cell Background - Select a background color for the selected table cell. You can use the
document's default background color as specified in Page Properties|Appearance, or define
a custom color. You can also use an image as the background.

Displaying Tables

If you plan to create large tables with many columns and rows, you might want to consider
displaying tables flat in order to save time and your computer's memory. You can still edit
individual cells and modify their properties when the table is flattened, and when you browse
your document the tables display normally. Select View|Display Tables (when the item is
checked it's selected) to display tables normally in the edit window. When View|Display
Tables is unchecked, the Composer displays a table as one long series of cells in successive
order. Borders and colors are not displayed. The following example shows a 2-column, 3-row
table with a normal display (View|Display Tables checked) on the left, and the same table
with a flattened display on the right.

Tables
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Netscape Composer Tutorial

Publishing
Now that you've learned the basics of Web page authoring with Composer, it's time to let
other people on the Internet see what you've accomplished. In this section you'll learn how to
publish your Web pages from Composer.

Quick Links:
Publishing Your Pages
Using One-Button Publishing
Publish Files dialog box

Publishing Your Pages

Once you have finished creating your Web page, or perhaps an entire Web presentation and
tested it on your own system, you can publish it to a server. Right now your page exists on
your local disk; you can browse your Web page, but no one else can. When you publish to a
server, you're copying your Web pages (HTML files) to a Web server so that others can see
what you've done.

What is a Web server?

A Web server is a program that runs all the time and waits for Web clients (such as
Navigator) to connect to it and request data, usually a file. Servers and browsers
communicate using the HyperText Transfer Protocol (HTTP), a language created for
transferring hypertext documents over the Web. Web servers are often called HTTPD
servers.

Note: The "D" in HTTPD stands for daemon. A daemon is a UNIX term for a program that sits
in the background and waits for requests. You don't have to be on UNIX for a program to
behave like a daemon, so Web servers on any platform are still called HTTPD servers, or
simply HTTP servers.

Finding a Web server

Ideally, you'll be able to publish your Web pages using the same organization that gives you
access to the Internet. If you get access to the Internet through a commercial provider, that
organization might offer Web space that you can use as well. Ask your system administrator
if they offer Web server access.

Filename Conventions

Filenames have different conventions and restrictions depending on the platform. It's
important to understand these distinctions before publishing your Web information, because
you want your documents to be as portable between platforms as possible. If you are working
with more than one platform, naming your files is very important.

For example, if you're moving your files to or from DOS-based systems, you'll need to follow
the 8.3 rule, which means that file names must be only 8 characters long with a 3-character
extension. Also, if you're moving files from a Macintosh to other systems, don't use spaces or
other funny characters, use only letters and numbers and keep your file names under 8
characters.

Publishing
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Using One-Button Publishing

The one-button publishing feature in Composer makes publishing your Web pages quick and
easy. You can select which files or directories you want to upload (publish) to a remote
server. You can also specify the remote server site.

Choose File|Publish or click the Publish button on the Composition toolbar. If you
have specified default publishing preferences in the Composer Preferences dialog,
those settings appear in the Publish dialog.

1.  

Select the "Files associated with this page" option to display all of the image files in the
current document (default). Then select any image files you want to publish along with
the document. Select the "All files in page's folder" option to display all of the files
(.HTML, .GIF, .JPG) in the current document's directory. Then select the files you want
to publish along with the document. This is a quick way to publish an entire Web
presentation that is made up of several HTML files. Note: If a file on the remote server
where you're publishing has the same file name as the one you're uploading, it will be
replaced with the new one without asking you to confirm the action.

2.  

Type the location of the remote site you want to publish your Web pages to. For
example, if you were using the FTP protocol, the URL you entered in this box might
look something like this:

ftp://ftp.chre.vt.edu/topfolder/myfolder/

Once you've typed some locations here, in the future you can select from the list of
remote locations you've established. Click Use Default Location to have the editor
automatically enter the location you've specified in your Editor preferences.

3.  

Publishing
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Type your user name in the appropriate space.4.  

Type the password for your user name in the appropriate space. Check "Save
Password" to save your password information so you don't need to retype it each time
you publish your Web pages.

5.  

Click OK to have Composer upload the files.6.  

Publish Files dialog box

Learn about each item on the Publish Files dialog box.

About the Publish Files dialog

Lets you select which files or directories you want to upload (publish) to a remote server. You
can also specify the remote server site.

Page Title - The title of the page you are publishing. The title will appear at the top of the
browser window.

HTML Filename - If you have already created and saved a page, this field is filled in. If not,
enter a filename for the current page you want to publish. The filename must have an .htm or
.html extension.

HTTP or FTP Location to publish to - Enter the location of the remote site where you want
to publish your web page.

Publishing
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User name - The name you type when accessing the network your Web pages will be
located on.

Password - The password for your user name.

Save Password - Saves your password information so that you only need to type it in the
box once instead of each time you publish your Web pages.

Files associated with this page - Click to display all of the files referenced by the current
document. Then select the files you want to publish along with the document. Click Select
None or Select All to quickly select and deselect files in the list.

All files in page's folder - Click to display all of the files in the current page's directory. Then
select the files you want to publish along with the page. Click Select None or Select All to
quickly select and deselect files in the list.

Warning: If a file on the remote server you're publishing to has the same filename as one
you're uploading, the newly uploaded file will replace the existing one. You will not be asked
to confirm the action.
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Netscape Composer Tutorial

Setting Page Properties
This section describes how to set overall document properties

Quick Links:
Page Properties - General Tab
Colors and Background Tab
META Tags Tab

Page Properties - General Tab

Choose Format/Page Colors and Properties to get the Page Properties dialog box. Here
you can set various properties for documents. When you're done, click Apply to make the
changes you've specified and leave the dialog box open. Click OK to make the changes and
close the dialog box.

About the General Page Properties dialog

Displays information about the current document and lets you provide additional information
helpful to Web users searching for specific topics. Click OK to make the specified changes
and close the dialog box. Click Apply to preview the changes you've specified and then click
Close to accept the changes and exit the dialog box.

Page Properties
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Location - The location of the current document on your local disk.

Title - The text you want to appear in the window title when the document is browsed.
Although optional, it's a good idea to specify a title for your documents since this is how most
Web search tools locate specific Web pages. So, if you want readers to be able to locate your
page easily, select a useful title that conveys what your page is all about.

Author - The name of the person who created the current document. This information can be
helpful to readers who've found your document by using a Web search tool and must now
select from a list.

Description - A brief description of the contents of your document. Again, this information
can be helpful to readers searching for a specific topic.

Other Attributes - Type keywords that you want searching services such as Yahoo to use to
help users locate your document on the Web. Type the category name (obtained from a
catalog server) you think best applies to your document. Classification names are another
method used by searching services to locate documents.

Page Properties - Colors and Background Tab

About the Page Properties Colors and Background dialog

Page Properties
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Lets you specify how to use the browser's colors for link text and document background or
specify custom colors for the current document (Page Properties), or for all documents
(Composer Preferences). Click OK to make the specified changes and close the dialog box.
Click Apply to preview the changes you've specified and then click Close to accept the
changes and exit the dialog box.

Use viewer's browser colors - The viewer's color preferences (specified in the General
preferences panel) will be used.

Use custom - Allows you to set your own colors for text, linked text, and document
background (default) and save it in the document.

Custom colors - Allows you to specify the color for Normal, Link, Active Link, and Followed
Link text. Click on a button to display the Color dialog and select the color you want. Sample
text in the color you've specified appears to the right.

Background - Click this to display the Color dialog and choose a solid color to appear as the
background for the current document.

Color schemes - Lets you select a scheme from the list.

Use image - Check this box to use an image as the background and type an image file
name. If you're not sure of the file name or its location, click Browse to select an image file
from the directory list. Note: Background images appear tiled and override background color
selections.

Page Properties
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Page Properties - META Tags Tab

This panel displays optional information that your online service provider might want you to
include in your document. This information doesn't actually appear in the document when
edited or browsed--only in the source HTML. Contact your provider for more information.
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Netscape Composer Tutorial

Setting Composer Preferences
The Composer Preferences dialog box lets you set various properties that you want to apply to all the
documents you create in the Composer. Use the Page Properties dialog when you want settings to
pertain only to the current document.

Quick Links:
Preferences - General
Preferences - Publish

Composer Preferences - General

Choose Edit|Preferences and then select Composer in the Category window.

Lets you specify which applications to open when you want to make changes to HTML (advanced
users) and image files. You can also indicate a default template file to use for all new documents.
Click OK to make the specified changes and close the dialog box.

Composer Prefs.
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Author name

The default name used by the editor to indicate who created a document. This information can be
helpful to readers who've found your document by using a Web search tool and must now select from
a list.

Auto Save

Specify the interval (in minutes) between automatic saves of your document. If you are working on a
new document that hasn't been saved, the editor prompts you to save it.

External editors

The path and file name of the text and image editors of your choice. For example, if you want to use
Notepad to edit the actual HTML source, type C:\WINDOWS\NOTEPAD.EXE. Choosing HTML
Source from the Edit menu starts Notepad with the current document displayed. If you're not sure of
the file name, click Browse to find the application. Note: When you edit HTML source using this
method, you must save your changes in the source editor and then choose View|Reload to see your
changes.

Font Size Mode

Select how Composer will display font sizes:
relative to the point size of the default Navigator font.
a relative HTML font scale (between -2 and +4).
relative to both HTML font scale and absolute point sizes.

Composer Preferences - Publish

To view the Publishing Preferences dialog box, click the plus sign next to the Composer category in
the left pane, then select Publishing.

This window lets you specify Composer settings for saving remote documents locally so you can edit
them, insert images, and publish files to remote servers. When you're done, click Apply to make the
changes you've specified and leave the dialog box open. Click OK to make the changes and close the
dialog box.

Composer Prefs.
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Maintain links

Makes sure that inserted links are relative to the current document. When saving a document from a
remote server to your local disk, this option insures that any links in that document to other files in the
same directory are relative when saved locally. These links will work locally if you've also saved the
remote files they pointed to. Links to files outside the document's directory are absolute. Unchecking
this option means that the link path names are not modified and links local to the saved document
may no longer work.

Keep images with page

Saves a copy of the image file in the same location as the document. Since images are not located in
the document itself, unchecking this option means that only the HTML document is saved locally, not
the image files. Leaving this option checked (recommended) means that a document's images are
always kept in the same directory as that document.

Default publishing location

FTP: Enter the default location where you want to upload your web pages using the File Transfer
Protocol. For example, the URL in this box might look something like this:

ftp://ftp.chre.vt.edu/topfolder/myfolder/

Composer Prefs.
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HTTP: Enter the default location where you want to upload your web pages using the web server
protocol (not used for this course). If you are not running your own web server, you may need to
contact your Internet service provider to find out what to type here. For example, the URL in this box
might look something like this:

http://websurf.com/docs/

If publishing to a FTP site, enter the HTTP address to browse to. Enter the default location of your
published web pages. For example, using the FTP example from above, you might type:

http://www.chre.vt.edu/topfolder/myfolder/index.htm
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Netscape Composer Tutorial

HTML and JavaScript
Strictly speaking, you don't need to know HTML to use the Composer. However, it pays to be
familiar with what's really going on inside an HTML document when you're troubleshooting a
Web page you're working on. If you don't get the results you want, it's useful to look at the
raw HTML file and tags to see what the problem might be.

Quick Links:
HTML Basics
JavaScript
Adding HTML or JavaScript

HTML Basics

An overview of Composer's use of HTML tags

Formatting in HTML documents consists of tags of plain ASCII text instructions enclosed in
angle brackets <>. A format area typically uses two tags: one at the beginning and another at
the end. For example, to designate a particular line as a heading, you enclose the heading
text inside tags that mark the beginning and end:

<H3>Hello World Wide Web!</H3>

The <H3> tag marks the beginning of text to be considered a level 3 heading (Heading 3); the
</H3> tag marks the end of the text heading. Instead of the usual manual way of inserting
this tag, the Composer lets you automatically apply an H1 format using the drop-down style
list on the Paragraph toolbar, or by choosing Format|Paragraph.

How Composer formats correspond to HTML tags

This Composer format Corresponds in HTML to

Address <address>

Formatted <PRE>

List Item <LI>

Unnumbered <UL>

Numbered <OL>

Directory <DIR>

Menu <MENU>

Description List <DL>

Description Title <DT>

Description Text <DD>

HTML and Java
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JavaScript

JavaScript, a Netscape-developed scripting language derived from Java, provides developers
with a simplified language to create scripts and small programs. With Composer, you too can
take advantage of the power of this scripting language in your Web pages.

JavaScript is a small, property-based scripting language. Scripts written in JavaScript can
enhance the features of Web pages, as well as client and server applications. For example, a
JavaScript script embedded in HTML can recognize and respond to user-initiated events
such as form input and page navigation.

Adding HTML or JavaScript

If you already have an understanding of HTML or Java and want to insert particular tags that
aren't available from the Composer's format menus, choose Insert|HTML Tag. A dialog box
appears that lets you type the HTML or Java you want to insert at the selected place in your
document.

HTML Tag dialog box

When typing tags in this box, press Enter at the end of each line to ensure that your code is
easily readable. Click Verify to have the Composer check the HTML you've typed. The
Composer checks to make sure you have both opening and closing brackets < > around your
HTML, and quotation marks around any attribute text.

This feature is particularly useful for inserting HTML form tags, and Java applet and plug-in
code into your documents. Although the Composer does not display these objects, it does
insert special HTML tag icons so you know where they are.

HTML tag icons

You can still insert and edit them using the HTML Tag box, and then browse your document
to see them. When you view the HTML source, you'll see <SCRIPT> and </SCRIPT> HTML
tags around your JavaScript statements.

Tip: Double-click the tag icons to display the HTML Tag box and quickly edit your HTML,
Java applet, or plug-in code.
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Netscape Composer Tutorial

Design Issues
In closing, we offer some issues to consider when designing and creating your web pages.

Quick Links:
About Page Design
Using Different Browsers
Setting Page Length
Providing Good Content
Doing Graphics Justice
Taking Stock of Colors and Fonts
Finishing Touches

About Page Design

Even though the Web is relatively young, there are already some definite do's and don'ts
regarding content creation. If you heed some of the following credos regarding text, page
length, graphics, and color, you'll be on your way to presenting an attractive and well-turned
Web page, one with content that readers will enjoyably sink their teeth into.

Time spent planning before you start "cooking" up your creation is time well spent. Consider
these issues:

What's the purpose of the page? Are you providing a service, a product, or
entertainment?

Who is your intended audience? Knowing your readers helps you shape the
information content and pick a consistent voice to address them.

How do you intend to structure the information? It's common to see at least two levels
of hierarchy: a top level index and second-level pages. Put as much content toward
the top of a hierarchy as possible. (This way, even the casual reader can quickly
grasp the sort of information you're presenting.) The easiest way to lay out your
information is by chunking it: break your topics into subtopics. If you have several
small topics, group them onto a single page.

How many links will you include? Remember that readers can create links that go to
your home page as well as to any page within your set of pages. Also, readers can
start to browse your Web page at any number of points; then navigate them in
arbitrary fashion, choosing where to start and stop browsing. When planning the
number of links you'll include, plan to test their validity on a regular basis.

How many pictures, sounds, and movies should you use? The fancier and more
complex your pages are, the more work and time you'll need to develop them. While
multimedia elements definitely add pizzazz to your pages, they also can make a page
take too long to load, delaying the reader from the information they're looking for.

Using Different Browsers

As the Web grows in popularity, more browsers are becoming available. This means you
can't assume that folks reading your pages are using the same browser you are. Even those

Design Issues
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who do use Netscape might not use it all the time (they might use a different browser at home
or at work).

Don't make your document overly dependent on HTML features that can't be seen by all
browsers. If you decide to use Netscape-only HTML tags, consider how your page might look
to someone whose browser doesn't support those tags. Some browsers might not accept
your graphics, so provide alternative text. Also, Netscape (and many other browsers) lets
users choose how they want the pages they view to look. Users can choose fonts and font
sizes, override a page's colors and backgrounds, and generally ignore a lot of the formatting
options a Web author has specified.

Do assume that a user's screen size, number of available colors, and screen resolution will
be different from yours, even those readers using the same browser. This means that a page
that looks great on your screen might look completely different on someone else's. This is
another strong reason to concentrate on content first, and use design options as
enhancements only.

Setting Page Length

Most current personal computer monitors display either 640 x 480 pixels or 800 x 600 pixels
on 15-inch to 17-inch screens. Designing your pages so that the information is presented in
short, clearly segmented chunks will make it easier to keep pages concise.

A good rule of thumb for writing a page meant to be read onscreen is to make it no longer
than two to three 640 x 480 screens' worth of information, including local navigational links at
either the beginning or the end of the page layout. If you make the page longer than the
window, your reader has to remember too much information that's already scrolled off the
screen.

A disadvantage of a very long Web page is that the reader must depend on the vertical scroll
bar slider to navigate. Small scrolling movements can completely change the screen
contents, leaving the reader no familiar landmarks.

Keep closely related information within the confines of a single Web page, particularly when
you expect the user to print or save the text. If you want to provide a good online interface for
pages and easy printing or saving of the content, divide the page into chunks of two to three
printed pages of worth information, including inline graphics or figures. Or provide a link to a
separate file that contains the full-length text combined into one page.

Providing Good Content

While the graphic design of your pages should be pleasing, it is ultimately the content that
determines a page's value to others. Follow these simple guidelines to giving good content:

Use graphics and color and vary the font size to enhance your page, but make sure
your page also works when viewed as straight text. And always include a text
alternative to graphic elements.

Pare down your text. Usability tests show that people will skip over text that they
consider non-essential. They don't like to scroll. Often readers will scan a page
reading only the text of the hypertext links before they choose their next destination.

Design Issues
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Settle on as few heading styles and subtitles as are necessary to organize your
content, then use your chosen styles consistently. Just because Composer provides
six levels of headings doesn't mean that you should use them all in a single page!
Use heading levels in order, with one level 1 heading at the top, and if necessary,
several level 2 headings. Be aware that different browsers use different spacing and
fonts. Use the heading levels to indicate structure, as they were intended.

Avoid overusing boldface, italics, and multiple font styles in your text. One thing you
can do to ease the monotony and visual strain of reading lots of text on the computer
screen is to use the Block Quote paragraph format and Unnumbered List format
(available in the Properties dialog box). Both formats result in indented text blocks
that shorten lines of text, keep margins clear, and generally make the page easier to
scan. You can also insert horizontal lines to visually separate sections of your
document.

Doing Graphics Justice

Graphics add a lot to the visual appeal and information content of a page. But poor use of
graphics can frustrate your readers or keep them from understanding the message you're
trying to send. Here are some points to keep in mind:

Practically every published Web author will agree: keep images small! You should
aim to keep the total file size of images used on a page to less than 100K.
Remember that not everyone seeing your page has a 56K modem. If you need to use
a large image, you might want to consider using a thumbnail of the image and then
linking it to the full-size copy. You can reduce file size by using design programs
(such as PhotoShop) to eliminate unnecessary colors.

Use backgrounds intelligently. Backgrounds that are "loud" make it extremely hard to
read the text that's on top of them. Don't let your backgrounds interfere with the
message you're sending the reader. For a background to work well, color contrast is
not enough. The background either needs to be very light (for dark text) or very dark
(for light text). A background that contains an image should have low contrast, so it's
not too distracting.

The two types of image formats used by most Web browsers are GIF (CompuServe
Graphics Interchange Format, .gif extension) and JPEG (Joint Photographic Experts
Group, .jpg extension). The JPEG format works best for photos and continuous tone
images. The GIF format works best for inline images, line art drawings, most logos,
and screen dumps. Both formats should use a resolution of 72 dpi (dots per inch) and
use RGB (red-green-blue) color mapping.

Since you can't assume your readers are using a graphical browser to view your
pages, be sure to enter an alternative description in the Text field of the Image
Properties dialog box (choose Format|Image Properties). This way, readers using
text-based browsers will see the alternate text description, and those using graphical
browsers will also see something if the image fails to load.

Use the Image properties dialog box to indicate the amount of space (in pixels) you
want around an image. This speeds up the downloading process because the server
doesn't need to request size dimensions to transmit to the client and can therefore
display text faster. You may have heard of an extended type of graphic image called
an image map. An image map is where different parts of the image activate different
links. Clicking on one area of the image takes you to a specified page, clicking
another area takes you to a different page, and so on.

Design Issues
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Taking Stock of Colors and Fonts

It's tempting to add lots of colors and font styles to a page just because you can. But the
result is more likely to frustrate a reader and detract from the message you're trying to get
across. After all, it's the content you want your audience to focus on, and that means
presenting a page that's easy to read. Even though most graphical browsers (including
Navigator) use a proportionally spaced font such as Times Roman as the default for text,
many browsers are user-configurable, meaning the user can choose any font for viewing your
page.

Consider typography as the tool you use to paint patterns on the page. The first thing your
reader sees is not the title or other details of the page, but the overall pattern and contrast of
the page. The reader's eye scans the page first as a purely graphic pattern, then begins to
track and decode type and page elements.

Good typography depends on the visual contrast between one font and another and the
contrast between text blocks and the surrounding empty space. There are a few basic
typographic principals that can help make your pages easier on the eye:

Avoid overusing boldface, italics, and multiple font styles in your text. Too much
contrast is just as bad as no contrast at all.

Making text uniformly bigger doesn't help at all, and only contributes to making the
pager longer.

Boldface fonts become monotonous very quickly, because if everything is bold,
nothing stands out, and it looks as if you're shouting at your readers. Using all
uppercase can have the same jarring effect.

Choose a few heading styles to organize your content, and then use your chosen
styles consistently. Regular, repeated patterns help readers quickly establish the
location and organization of your information, and increase the overall legibility of
your pages.

Use white space judiciously. Don't put blank lines or horizontal rules everywhere or
your pages will look choppy. (Plus, you're trying to keep page length to a minimum.)

Thoughtful and consistent use of color in backgrounds can really help pull your pages
together into a cohesive presentation. In general, light pastel backgrounds are best for
reading substantial amounts of text. If you are showing a lot of pictures, a black background
can make your photos look good and give your pages a gallery-like effect. Using tiled
backgrounds makes everything above them "float," causing your readers to work much
harder to read your text. Using a white background can make text look good and your
document look clean, but if you have a lot of pages, it can be extremely wearing on the eyes.

Finishing Touches

And last, but not least, the proverbial icing on the cake. These elements are considered the
hallmarks of the work of a professional Web author:

Headers: A consistent titling design at the top of your Web page allows your readers to
immediately know what the main point of the document is, and what (if any) relationship the
page might have to other pages in a related group. Unlike a browsing a book, which is linear
in design, a Web author can never be sure what other pages the reader has seen before
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linking to the current page. Graphics placed above the main heading should not be so large
that they force the title of the page on a standard office-size monitor (640 x 480 pixels) to go
off the screen.

Footers: Ideally, each page should have a footer that contains your name, organization,
navigational elements (links or icons), copyright information, and revision/change dates.

Email Address: Like any fine work of art, a good Web page should have a signature or some
other form of contact information. You can provide a link to an email form your readers can
use to send comments and feedback to you. Select the Link tab in the Properties dialog box.
In the Link to field, type the HTML tag mailto: followed by your email address.

At the very least, provide your name, organization, and street address, in case your page is
viewed on a browser that doesn't support email forms.

Navigation: Include a target (a return link) to your top level on each page so readers have a
quick way of returning to the beginning. It also helps to include links to an index or table of
contents, other sections, and previous and next pages. You might want to add these targets
to the bottom of the page, so the reader always knows where to find them. If your links only
flow downward from the home page, the pages in your document will become dead ends.

Links: Avoid the "click here" syndrome when defining a link; for example, "Get information
about whatever is available by clicking here." Readers then have to remember where they're
going to once they jump to another page. It's better to link to words or phrases that are a
meaningful part of a sentence; for example, "Information about whatever is now available."

If you use links to items on the same page, remember to use relative links, as absolute links
(full URLs) can cause a browser to reload the page each time a link is selected.

Time Stamps: Date your revisions and indicate those pages that have been changed or are
new additions.
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